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Document copyright policy:

You agree not to reproduce, other than for your own personal, noncommercial use, all or part
of this document on any medium whatsoever without permission of Schneider Electric, given in
writing. You also agree not to establish any hypertext links to this document or its content.

Schneider Electric does not grant any right or license for the personal and noncommercial use of
the document or its content, except for a non-exclusive license to consult it on an "as is" basis,
at your own risk. All other rights are reserved.

All pertinent state, regional, and local safety regulations must be observed when installing and
using this product. For reasons of safety and to help ensure compliance with documented
system data, only the manufacturer should perform repairs to components.

When devices are used for applications with technical safety requirements, the relevant
instructions must be followed.

Failure to use Schneider Electric software or approved software with our hardware products
may result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.
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Safety Information @

Important Information

NOTICE

Read these instructions carefully and look at the equipment to become familiar with the device before trying
toinstall, operate, service, or maintain it. The following special messages may appear throughout this

documentation or on the equipment to warn of potential hazards or to call attention to information that clarifies
or simplifies a procedure.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an
electrical hazard exists which will result in personal injury if the instructions are not
followed.

hazards. Obey all safety messages that follow this symbol to avoid possible injury or
death.

/: This is the safety alert symbol. It is used to alert you to potential personal injury

A DANGER

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious
injury.

A WARNING

WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A CAUTION

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE

NOTICE is used to address practices not related to physical injury.

PLEASE NOTE

Electrical equipment should be installed, operated, serviced, and maintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of
the use of this material.

A qualified person is one who has skills and knowledge related to the construction and operation

of electrical equipment and its installation and has received safety training to recognize and avoid
the hazards involved.
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About the Book @

At a Glance

Document Scope
This manual describes how to use this product.

Validity Note
This documentation is valid for this product.
The technical characteristics of the device(s) described in this manual also appear online at
https://www.proface.com.

The characteristics presented in the present document should be the same as those that appear online. Inline
with our policy of constant improvement we may revise content over time to improve clarity and accuracy. In the
event that you see a difference between the document and online information, use the online information as
your reference.

Registered Trademarks

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or other
countries.

Product names used in this manual may be the registered trademarks owned by the respective proprietors.

Related Documents

You can download the manuals related to this product, such as the software manual, from our support site at
https.//www.proface.com/trans/en/manual/1001.html.

Product Related Information

If the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment
may be impaired.

In the event this product does not run properly due to whatever reason, it may be difficult or impossible to identify
a function. Functions that may present a hazard if notimmediately executed, such as a fuel shut-off, must be
provided independently of this product. The machine’s control system design must take into account the operator
being unable to control the machine or making mistakes in the control of the machine.

A WARNING

UNINTENDED EQUIPMENT OPERATION

The application of this product requires expertise in the design and programming of control
systems. Only persons with such expertise should be allowed to program, install, alter, and
apply this product.

e Follow all local and national safety standards.

Failure to follow these instructions can result in death, serious injury, or equipment

damaage.

For additional information, refer to NEMA ICS 1.1 (latest edition), "Safety Guidelines for the Application,
Installation, and Maintenance of Solid State Control" and to NEMA ICS 7.1 (latest edition), "Safety
Standards for Construction and Guide for Selection, Installation and Operation of Adjustable-Speed
Drive Systems" or their equivalent governing your particular location.
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Target: ST-6500WAD
Driver: None

BLUE version 3.4.100 or later

Template Overview

This template has Voice Messages list in Alphabetical Order in Japanese language.

Project structure

On Simple_GPC_Sound02_Guide, 1 content displays are placed.
620 to 655 contents is called in Simple_ GPC_Sound02_Guide screen.

Screen

GPC_Sound02_Guide

ContentsDisplay1
(Content 1D:620)

GPC_Sound02_AA

ContentsDisplay1
(Content ID: 621)

GPC_Sound02_lI

ContentsDisplay1
(Content ID: 622)

GPC_Sound02_UU

ContentsDisplay1
(Content ID: 623)

GPC_Sound02_EE

ContentsDisplay1
(Content ID: 624)

GPC_Sound02_0O0O

ContentsDisplay1
(Content ID: 625)

GPC_Sound02_KA

ContentsDisplay1
(Content ID: 626)

GPC_Sound02_KiI

ContentsDisplay1
(Content ID: 627)

GPC_Sound02_KU

ContentsDisplay1
(Content ID: 628)

GPC_Sound02_KE

ContentsDisplay1
(Content ID: 629)

GPC_Sound02_KO

ContentsDisplay1
(Content ID: 630)

GPC_Sound02_SA

Copyright (C) Pro-face by Schneider Electric. All Rights Reserved.

Public




Pro-face

by Schneider Electric

ContentsDisplay1
(Content ID: 631)

GPC_Sound02_SI

ContentsDisplay1
(Content ID: 632)

GPC_Sound02_SU

ContentsDisplay1
(Content ID: 633)

GPC_Sound02_SE

ContentsDisplay1
(Content ID: 634)

GPC_Sound02_SO

ContentsDisplay1
(Content ID: 635)

GPC_Sound02_TA

ContentsDisplay1
(Content ID: 636)

GPC_Sound02_TI

ContentsDisplay1
(Content ID: 637)

GPC_Sound02_TU

ContentsDisplay1
(Content ID: 638)

GPC_Sound02_TE

ContentsDisplay1
(Content ID: 639)

GPC_Sound02_TO

ContentsDisplay1
(Content ID: 640)

GPC_Sound02_NI

ContentsDisplay1
(Content ID: 641)

GPC_Sound02_NE

ContentsDisplay1
(Content ID: 642)

GPC_Sound02_HA

ContentsDisplay1
(Content ID: 643)

GPC_Sound02_HI

ContentsDisplay1
(Content ID: 644)

GPC_Sound02_HU

ContentsDisplay1
(Content ID: 645)

GPC_Sound02_HO

ContentsDisplay1
(Content ID: 646)

GPC_Sound02_MA

ContentsDisplay1
(Content ID: 647)

GPC_Sound02_MI

ContentsDisplay1
(Content ID: 648)

GPC_Sound02_ME
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ContentsDisplay1 GPC_Sound02_MO
(Content ID: 649)

ContentsDisplay1 GPC_Sound02_YU
(Content ID: 650)

ContentsDisplay1 GPC_Sound02_YO
(Content ID: 651)

ContentsDisplay1 GPC_Sound02_RA
(Content ID: 652)

ContentsDisplay1 GPC_Sound02_RI
(Content ID: 653)

ContentsDisplay1 GPC_Sound02_RO
(Content ID: 654)

ContentsDisplay1 GPC_Sound02_WA
(Content ID: 655)

’—~ Content Display

L) 5 = B FHDET, CEECEIL, AA_D0D010.wav C]
B IS AA_DDD20.wav S
D\ % < [j - ERCEBLTLEEN AA_0D030.wav [:]
= W g jes = ER AA_00D4D. wav :]
ENHLRLELE. AA_D0DO50.wav S

Iz ®, T &
ENHETLELE AM_00060. wav D
[C n FPFYa-FUtw NG, AA_DDO70.wav (:]
g ol & g | somescausLy movoconss ([
BEEBTANLTLREE L AA_DDD90.wav :]

E3 4 & B
AA_DD100.wav :]
K RS AA_DD110.wav C]
5 O ;_,-) TeT HMSLTLETY AA_DD120.wav D
TERENHILELE AA_D0130.wav [:]

EZREESBLTIEZN AA_DD140.way
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Run Time Behavior
Runtime/Simulation of this template displays a Voice Message list for each Alphabets
with Sound Check Button in Japanese. Click on any Alphabet and check the Message

list on the same.

Copyright (C) Pro-face by Schneider Electric. All Rights Reserved.
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How to copy the objects to your project file
1. Open your project file and downloaded project file simultaneously.

ozt . x
BLUE BLUE =
DBy 8y X |5 DBEvEBy X avm ¥ B B § swoom v owmee v BEviDvd ?2v gy @y

11GPC_Sound02 Guide x B3

B B 1 v i B DB \ av i Saen v P & QvIsQaQ =B Q

> [ Project > DPrct ik w0, 0w o s e oo oo oo hooo (oo (oo 300 | eac sounonn cuie

> %2 System Architecture > % System Architecture s

< [ Screen Design B Screen Design 2

Descripton
M Screens (1) < W saeens )
g Bic @ @
I Contents (0) < M Contents (36) 5 wone (D | ¢ & i 8
ad > (GPC_Sound02 ~ 00040
s Mo g g woar ([ e > woigaionsicn

> & Scripts > Meypa | 5

> [ Variables > B saipts NS

> [ Alarms/Events > [ Variables _ i<

— " g

> [& Logging > [0 Alamms/Events Blaglols

> [E Recipes > @ Logaing

> & Security > B Recipes =% » 28

> [ Language Table > B Secuity o] & | mEmsEAALTCRRL ree -

> {3 Converters > Bl Language Table g 5l p 3 = 27, woon: ([

> {3 Converters 3 FEEROTOLIL SO0 wer -
g samramLTCrE oo [
Description

g

Tool Chest ~ Project Explorer Tool Chest ~ Project Explorer @ Properties  Objectlist  Events

rrors | Reteences vax

o 08 " u]
Description Toget Type Targetath Source Path

References  Errors References  Errors

2. Open the downloaded project file.
Click the GPC_Sound02 Content folder from “Contents” and copy the content using
B2 copy icon in global Toolbar.

GPC_Sound02.blu

BLUE
O B v B v X|&® v A v .%EE B W State 0 (OFF) ™ Japanese ~ By D v b 2?2 v oE

Project Explorer 1:GPC_Sound02_Guide X I
B [ ™ | L = VO Screen % Order | = Align ~ | & Group Vv | @& Rotate v | EQ Q v 51 % & E
> [ Project o, |10, 20 [s00  |a0  [s00  [oo0 700 [s00  s00 (1000 110|120, [1300,
> 5§ System Architecture
== 1 =
[ Screen Design 3 TRy —YOREFERRLTIREL { 77008
= | = = ~ LHoEs. CEECESL. AA_D0D10.wav
[l Screens (1) = | i} Ly 2 A H -
A= BEEICTERCESL, AA_D0D20.wav
E 500001 : GPC_Sound02_Guide [Grid] = D\ < | DL — -
| S W | B Wl =7 wnoomzo e ()
v f
fi Contents 36 & (csl L] o|[¢] 7w prs—
1= ST g mmmes s
I_— = z5|>]<|¢t )
> .Keypad oo ENTEFLELR. AA_D0D60.wav -
> seript = 1 I | B ey e, sacecrens (D)
cripts ==
f=3 {
== | | EOHESTENELR. AA_00080.wav
> [ Variables = | '? ) U 5\ | G % -
- ERESTAALTLESL, AA_00090.wav -
> & Alarms/Events = F s | & B - -
(= — E— EBEESEHEL(ESL. AA_D0100.wav -
> [ Logging = 8 K & | EmmseaaLTRaL sasorover (D)
= : g
> R9C|P95 == 8 5 5} | = TEh/ - HEBUTUET. AR_00120.wav -
> & security = ¥ F2aEIEBLELE. AA_00130.mav -
== B
> [ Language Table = D | ZemmsasLTEEL aa_oorsomav (N
3
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3. Open your project file.

Click “Contents” and then click on the paste @ icon from the global Toolbar.

BLUE
0D 5 v v X [ ~1
5 & I L - v H Screen
> [ Project -
> Bd System Architecture I
e Screen Design =
~ [M Screens (1)
[E3 s00001 : Screent [Canvas] s
> [l Keypad =
=
> [E Seripts
> [ Variables g

> [& Alarms/Events

4. Select desired content ID and click “OK”.

&
(L,

v B Order = Alig

100 200 300

Result: Copied content is successfully pasted in your project.

New Content

Paste-To Content ID 1

OK Cancel

=

BLUE
0O gy By X &v A ¥ B B B9
Project Explorer -0 X
B e b= Screen T Ordes
> I Screens (1) 0 |, |100
~ [l Contents (36)
(-
[} C00001 : GPC_Sound02_AA [Grid] -
BB C00002 : GPC_Sound02_Il [Grid] =
2 RACESLTHEE.

[ C00003 : GPC_Sound02_UU [Grid]

=) C00004 : GPC_Sound02_EE [Grid] —_ -

C00005 : GPC_S: d02_00 [Grid;
B ~sound02.00 fricl EAFERLELE.

200

Copyright (C) Pro-face by Schneider Electric. All Rights Reserved.
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downloaded project.

Select the Pasted content in your project and change the Content ID as per

Properties w 0 X

S Properties = Bl
MName GPC_Sound02_AA
Type Content
Description
Basic
Content ID 620 O

and click on Copy.

BLUE

D gy v X | & v A v

Project Explorer

B & T L v

> [ Project
> B System Architecture
e Screen Design

v . Screens (1)

B3 500001 : GPC_Sound0?2_Guide [Grid]

~ [M Contents (36)
> [ GPC_Sound02
> M Keypad
= Scripts
Variables
E Alarms/Events
& Logging
Recipes
E Security
[F] Language Table

R N

{7 Converters

Copyright (C) Pro-face by Schneider Electric. All Rights Reserved.

kY WG [

Screen

600/ . 500/ . 400/ . 300 . =200 . o100

7000

T Order

GPC_Sound02.blu

B State 0 (OFF)  ~  Japanese v [[Bv

v | = ANign v | @ Group Vv | @ Rotate v

200 oo, l400 500 600 700

Open the downloaded project file and select the GPC_Sound02_Guide Screen

LHDET, SEECREL,
= BB TERCREL,
| BRCEELTCRS L.
ENRETT.
ENHESLELE.
ENPEFLELE.
e PIYI-FUty RNG.
| & || [F  ForeoELELR
- EEESTANILTCERL.
S Wl D} S REESEHALCEEL.
BEESEANIL TR,
5 EED-IBMELTUET,
T ZTEEELEUR.

| mzEREsBLTIESL,

AA_00010.wav

AA_00020.wav

AA_00030.wav

AA_00040.wav

AA_00050.wav

AA_00060.wav

AA_00070.wav

AA_00080.wav

AA_00090.wav

AA_00100.wav

AA_00110.wav

AA_00120.wav

AA_00130.wav

AA_00140.wav
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7. Open your project file, Select the screen that you want to paste it.
Click on the screen area and then paste it using the paste icon from the global
Toolbar.

BLUE
h g~ By X = v /A&l 8 BBl T

Project Explorer
= [e 1 NP 1~ i Screen v T Order = Alic
>DProject Q 1199, 1200, 30
> B2 System Architecture 2
~ Screen Design

e . Screens (1) ==

@ S00001 : Screen1 [Canvas] 3 / \L
= c\c
[ Contents (0) &

> [ Keypad -
> [ Scripts g
> [ Variables =

8. Open the downloaded project file and select “All variables”. Select the displayed
variables folder and click the copy icon from global Toolbar.

GPC_Sound02.blu

BLUE
ODb g~ B v X | =« /& v B E B @ Japanese ~ B> D v o] ?2 v

Project Explorer

@ Folder = B @ WORD ~ F N &l =] O || & variavles
> D Project Folder Name Data Type Source Scan Ra
> BE system Architecture > GPC_Sound0D2  AA BOOL Internal
> Screen Design > GPC_Sound02 I BOOL Internal
> Scripts
E P > GPC_Sound02 UU BOOL Internal
hd Variables
> GPC_Sound02 EE BOOL Internal
~ All Variables (300)
- . 402 (300) > GPC_Sound02 [e]e] BOOL Internal
GPC_Soun 3
Symbol Link > GPC_Sound02 KA BOOL Internal
> All User Data Types (0) > GPC_Sound02 KI BOOL Internal
- All Scan Rates (1) > GPC_Sound02 KU BOOL Internal
> [& Alarms/Events > GPC_SoundD2  KE BOOL Internal
> [E logaing > GPC_Sound02 KO BOOL Internal
> Recipes
> GPC_Sound02 SA BOOL Internal
> E Security
> GPC_Sound02 Sl BOOL Internal
> A Language Table
> D Converters > GPC_Sound02 SuU BOOL Internal
> GPC_Sound02 SE BOOL Internal
> GPC_Sound02 _SO BOOL Internal

Tool Chest Project Explorer

Copyright (C) Pro-face by Schneider Electric. All Rights Reserved.
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9. Open your project file and select “All Variables”.
Click an existing variable or a blank Variable and click paste icon in global toolbar.

BLUE

D BBy X _vAvii BB T v
Project Explorer *1X
@ Folder sav i @ woro v | @ RS g |G
> [ Project Folder Name Data Type

> 5 System Architecture
> Screen Design

> [E] Scripts /

v Variables Oy
[ Al Variables (0)

Symbol Link

The copied variable is pasted in your project.

10. Open your Project, Click on Folder in All Variables and Change Folder Name
According to Downloaded Project, if required.

watitlage

BLUE
D EvEvXIAavAviBEY T VIBY D vl ? v gV
Project Explorer *qX Variables by + | Properties
@ Folder av i @wr viR | S & G | fig || vorigbtes Name  Folder]
>DProject Folder Name Data Type Source Number of Type  VariableFolder
> 52 System Architecture > Foldert A BoOL Internal 0
? [ Screen Design > Foldert I BO0L Internal 0
> [E] Scripts
E P > Foldert uJ BOOL Internal 0
v E\Iariables
> Foldert EE BOOL Internal 0

[l All Variables (300)

> Foldert 00 BOOL Internal 0
I Foldert (300)

> Folder? KA BOOL Internal 0
Symbol Link Older nterna

Copyright (C) Pro-face by Schneider Electric. All Rights Reserved.
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11.

BLUE

D &y By X|®& v A~ %@g]ﬁlapanese ~

Project Explorer
2 [ N2 v i @ Blank
1
> [ Project
> B2 System Architecture 2
0000
> Screen Design I L
- i 3
Il Scripts
1
> [ Variables
> @ Alarms/Events 2
[0001]
> [& Logging
> Recipes 3
> @ Security
1
> [ Language Table
> {3 Converters 2
[0002]
3
1
2
[0003]
3
Tool Chest  Project Explorer

Open All Scripts and Select All Scripts in Editor and Click on Copy in Global Tool
Bar.

GPC_soundoz.blu

By b v &b 2?2 v

All Scripts

N Find

Replace

onCondition(GPC_Sounde2.AA[e] ==
deadBandvalue: @ }, () => {

| launchapplication("c:\\Program Files\\videoLAN\\VLC\\vlc.exe", "C:\\GPC_Sounde2\\AA_eee10.wav
--play-and-exit --qt-start-minimized --gt-minimal-view --gt-notification=8", {
preventMultipleInstance: false, windowTitle: "", findWholeWindow: false }, false);

1

1, { enableDelay: false, enableDeadband: false, delayvalue: o,

onCondition(GPC_Sound@2.AA[1] ==
deadBandvalue: @ }, () => {

| JaunchApplication("C:\\Program Files\\VideoLAN\\VLC\\vlc.exe", "C:\\GPC_Sound@2\\AA_000820.wav
--play-and-exit --qgt-start-minimized --gt-minimal-view --gt-notification=6", {
preventMultipleInstance: false, windowTitle: "", findwholeWindow: false }, false);

1)

» { enableDelay: false, enableDeadband: false, delayValue: @,

onCondition(GPC_Sounde2.AA[2] ==
deadBandvalue: © }, () => {

| launchapplication("C:\\Program Files\\videoLAN\\VLC\\vlc.exe", "C:\\GPC_sound@2\\AA 0003@.wav
--play-and-exit --qgt-start-minimized --qt-minimal-view --qt-notification=e", {
preventMultipleInstance: false, windowTitle: "", findWholeWindow: false }, false);

15

1, { enableDelay: false, enableDeadband: false, delayvalue: o,

onCondition(GPC_Sounde2.AA[3] ==
deadBandvalue: © }, () => {

| launchapplication("C:\\Program Files\\videoLAN\\VLC\\vlc.exe", "C:\\GPC_Sound@2\\AA 00048.wav
--play-and-exit --gt-start-minimized --gt-minimal-view --gt-notification=6", {
preventMultipleInstance: false, windowTitle: "", findwholewindow: false }, false);

1)

1, { enableDelay: false, enableDeadband: false, delayvalue: o,

Note: All Scripts Can’t be copy if user project is in Block Script mode.

12. Open your project file, Convert Text mode in project settings and Select All Scripts
and click on Paste in Global Tool bar.

BLUE
0O 5 v

v 9 Project

ﬁ Settings

A

52 System Architecture
e Screen Design

> | Screens (1)

> [l Contents (20)

> [l Keypad

v & Scripts

5

X | m v Aav| Yy Bfm @
- O X All Scripts X I
=~ i @ Blank v N

M All Scripts

Copyright (C) Pro-face by Schneider Electric. All Rights Reserved.
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13. Open the downloaded project file, select “All Languages”. Click the export icon
from the local Toolbar and save in desired path.

BLUE

D 5 By Xy Av|¥ B B &) W/ japanese v [[BYV
Project Explorer * 0 X

v i @ Table @ Text | Importfj?o) S Lan
b D Project D ()1 Japanese Japanese_Gothic W
> 5" System Architecture 1300 EAYEE. CEECRAL
> [id Screen Design
1301 BbELTEECEL.

> = Scripts
>l Variables 1302 RBRICESLTGEL.
> [ Alarms/Events 1303 ENERTT.
> [& Logging 1304 EAtEFLELE.
> [& Recipes 1305 EAMEFLELE.
> [ Security 1306 77Y3-5UtYRN G.

<

[] Language Table

1307 BUNMEIZENELE.
. Il Al Languages (1 x 299)

1308 BIEESTAALTEL,
> {3 Converters
1309 BIIESELITFLGEEN.

1310 BIIESEAALTGRL.

Copyright (C) Pro-face by Schneider Electric. All Rights Reserved.
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14. Open your project file, select “All Languages”. Click the import icon from the local

Toolbar.

VoV OV OV VY VYNV VY

<

BLUE
O =5 ~ B ~ X | = Ao~ | 3 B B & o

Variabl

~ @ X | Al Scripts
@ Table

3 Project D
22 System Architecture

Screen Design

= Scripts

= variables

& Alarms/Events

= Logging

Recipes

= Security

[ Language Table

Il ANl Languages (0 x 0)

{3 Converters

15. Select the path (where it is exported), File name, File Type and Add/Replace

existing from the dialog and Click Open.

Import Language Text File

Source

C\Users\SESA666364\Documents',Pro-face\BLUE 3.5\Projects s

O Add to existing items

O Overwrite existing items

MNote: Undo is unavailable for the import operation. The current undo/redo stack will be cleared. Continue?

OK Cancel

Result: All language text will be imported to your project.

Note: You can also use your desired language text. For more details, refer How to

Configure Language Table.

Copyright (C) Pro-face by Schneider Electric. All Rights Reserved.
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How to Configure Language Table
To add any new languages for the existing text, follow below steps:

1. Select “All Languages” and in grid editor click Add Table icon in local toolbar.

BLUE

0O &g v voX
Project Explorer

I~ i @ Text &) Import | &) Export E?‘B S Lan
> DProject ID ()1 Japanese Japanese_Gothic e
> 7 System Architecture 1300 ERYET, TESEE.
> Screen Design
1301 BBLCTEEE.

> [E Scripts
> B Variables 1302 ERICEELTGREN,
> [& Alarms/Events 1303 ENERTT.
> [E Logging 1304 EARERLEL R
> [&@ Recipes 1305 EAMEFLELE.
> [ Security 1306 FIYI-FUEYENG.

~ [ Language Table

1307 HYMEITENELE
. [ All Languages (1 x 299)
1308 BHESTAALTGEN.

> {3 Converters

1309 BIIESESFLGEL.

1310 BIFESEADLTGEEL,

Result: New language table will be added Click on drop-down of newly added

2. table and select your desired language.

3 Tablel EnglishGothic =

English_Gothic

French_Gothic
German_Gothic
Italian_Gothic
Portuguese_Gothic

Spanish_Gothic

Copyright (C) Pro-face by Schneider Electric. All Rights Reserved.
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3. Select Language text in Grid editor. Edit the value as per your requirement.

3 Tablel FrenchGothic b

[Empty]
[Empty]
[Empty]

To delete any existing language table,

1. Select “All Languages” then select the table which you want to delete.

BLUE
| =~ ~ X = v A ¥ B By Japanese ~ A\ ~

Project Explorer

-~ g @ Table P Text I Import &) Export EE'@; S L
> [ Project D © 1 Japanese Japanese_Gothic ~
5 .

% system Architecture 1300 EAYET. TEELREL.
> Screen Design
1301 BHEICTEEES .
> [E Scripts
— 1302 BITISES LTS
> Variables 7T
> [& Alarms/Events 1303 EhE®CT.
> [ Logging 1304 EAHNERLELE.
> Recipes 1305 EAMEFLELE.
> [ security 1306 FIYI-FULYENG.
~ [ Language Table
1307 BUNESTEWELIZ.

Il A1l Languages (1 x 299)

e M SomI S e Al st

2. Click on delete icon in global toolbar.

3. Select the language to be deleted in popup and click ok.

Confirm

© Delete Language Tables
Select table to remove

1 : Japanese

) Delete selected text (rows)

OK Cancel
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Result: selected language table will be deleted.

To add any language text, follow below steps:

1. Select “All Languages” and in grid editor, click Add Text icon in local toolbar.

BLUE

O 5~ B v X|[® v AV}

Project Explorer v aXx

D Project

Eﬁq System Architecture
Screen Design

E Scripts

E Variables

E Alarms/Events

= Logging
Recipes

Fal Security

V ﬂE] Language Table
.. All Languages (1 x 299)
> {4 Converters

NN N N N N N N

@ Table

B (B & W | Japanese

@ Text -@ﬁ Import

ID

1300

1301

1302

1303

1304

1305

1306

1307

1308

1309

1310

Result: New text will be added in the editor

2. Select the text and edit the value as per your requirement for all languages.

+ Table + Text @ Import @ Export

()1 Japanese Japanese_Gothic

ERUET. TESEE.
RELLTES =L,
ElCESLTCEN.
EHEFTT.
EAAERLELE.
EAMEFLELE.
FIUI-FUEYENG.
HUNESTENZELTE.
BEFESTAALTEL.
BIFESESITFLOEL.

BAESEANLTUSEL,

63 Export

A

O

‘- ID 1 English  EnglishGothic -

1 [Empty]

2

[Empty]

Japanese  JapaneseGothic

=

[Empty]
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